
DELMIA Solutions Version 5 Release 20
Product Enhancement Overview

Process & Resource Detailing (V5)
●     3D Functional Tolerancing and Annotation

●     DPM Assembly Process Simulation

●     DPM Fastening Process Planner

●     DPM Machining Process Planner

●     DPM Process and Resource Definition

●     DPM Review

●     Electrical Harness Simulation

●     Generative Shape Design, Optimizer, Developed Shapes & BiW Templates

●     Manufacturing System Definition

●     Part Design

●     PPR Navigator

●     Real Time Rendering

●     Sketcher

●     Tool Selection Assistant

●     Wireframe and Surface

Factory Layout & Robotics (V5)
●     Device Building

●     Device Task Definition

●     Workcell Sequencing

Factory DMU (V5)
●     Kinematics Simulator

Ergonomics
●     Human Activity Analysis

●     Human Builder

●     Human Measurements Editor

●     Human Task Simulation

Off-line Programming (V5)
●     3 Axis Surface Machining

●     Lathe Machining

●     Multi-Axis Machining

●     Multi-Slide Lathe Machining



●     Multi-Pockets Machining

●     NC Machine Tool Builder

●     NC Machine Tool Simulation

●     NC Manufacturing Infrastructure

●     Prismatic Machining

●     Prismatic Machining Preparation Assistant

Work Instructions (V5)
●     DPM Work Instructions

●     Generative Drafting

●     Interactive Drafting

●     Shop Order Review

MULTICAx (V5)
●     MULTICAx AD Plug-in

●     MULTICAx ID Plug-in

●     MULTICAx PD Plug-in

●     MULTICAx SolidEdge Plug-in

●     MULTICAx Unigraphics Plug-in

DELMIA Automation (V5)
●     CSM Module and Block Editor

●     HMI Control Panel Design

●     CLM Device Logic Design

●     CLM SFC Editor

●     CLM FBD Editor

●     CLM Ladder Logic

●     CSM Device Control Connection

DELMIA Infrastructure Solutions (V5)
●     3D Manufacturing for Simulation

●     Data Exchange Interface

●     Infrastructure

●     Product Structure

DELMIA Process Engineer (DPE)

DPE functionalities are listed by the manuals in which they are addressed.  In most, but not all cases, manual names correspond to 
product names.

●     Administrative Tasks



●     Automatic Line Balancing

●     Engineering Hub - Manufacturing Hub V5

●     Finder

●     General Introduction

●     Graphic Tools

●     Manufacturing Change Management

●     PPR Navigator

●     Project Library

●     Scripting

●     Settings

●     User Management

●     Web Service Installation



3D Functional Tolerancing and Annotation

New Functionalities

Activating and Displaying a View/Annotation Plane
The Display View contextual menu command allows you to display selected view/annotation plane.

Analyzing Display Mode
The Analysis Display Mode option allows you to display and customize the color display for true dimensions, dimensions 
and annotations on deleted geometry, dimensions and annotations on unloaded geometry and invalid dimensions and 
annotations.

Creating an Annotation Set from an Existing One
The new New Annotation Set From... command allows you to create a new annotation set from an existing one in another 
CATPart document with certain rules.

Displaying a Tolerancing Capture
The Display and Set Current Capture command allows you to display the capture and to associate from now new created 
annotations, views, annotation planes with the capture.

Dimensioning Chamfers
The Chamfer Dimension command displayed in the Tolerancing Advisor on selecting a chamfered surface allows you to 
create chamfer dimensions and tolerances.

DS ISO 1 Open Type Font
This font allows you to represent annotations that follow the ISO norms defining text representation (ISO 3098 norms). Four 
new standards (ISO_DS, ISO_3D_DS, JIS_DS, JIS_3D_DS) are available that use DS ISO 1 as the default font.

Basic Review Capabilities of 3D XML Features Within 3D XML Player and 3D Live
Functional Tolerancing & Annotations features in 3D XML can be reviewed within 3D XML Player and 3D Live (without 
requiring the Live FTA Review license).

Reordering Features in the Specification Tree
Reordering of view/annotation planes, datums, datum targets and tolerancing captures is possible in the specification tree.

Tolerancing of User Features

Tolerancing User Features Automatically
The User Feature Tolerance command displayed in the Tolerancing Advisor on selecting an user feature or technological 
result of user feature for which a tolerancing schema has been defined allows you to automatically tolerance user features or 
technological result of user feature.

Tolerancing Schema Catalog
The administrator can define the tolerancing schema catalog for automatic tolerancing of user features or technological result 
of user feature.

User Feature Tolerances Administration Toolbar
This new toolbar is available for tolerancing schema creation.

View Orientation Management

View/Annotation Planes
The new View Creation command for plane creation replaces the previous commands: Front View, Section View and 
Section Cut View.

View Creation dialog box
The View Creation dialog box enables you to create View/Annotation planes. 

Change View Support dialog box
The Change View Support dialog box allows you to change the orientation of views by changing the definition plane of a view.

Views/Annotation Planes Toolbar
The new View Creation command for plane creation has been added in this toolbar and replaces the previous commands: 
Front View, Section View and Section Cut View.

Enhanced Functionalities

All Possible Types Option in Semantic Tolerancing Advisor dialog box
The All Possible Types option in the Semantic Tolerancing Advisor dialog box displays all the possible commands in the 



Commands frame and automatically updates the Geometry feature type list to All possible types option.
Clipping Annotation Plane

The clipping is displayed for Aligned/Offset Section Cut/View when using the Clipping Plane or Select command (with the 
3D-Annotation-Query Switch On/Switch Off option command active).

Creating an Automatic Default Annotation
The fillet radius criteria can now be taken into account in the fillet faces selection.

Creating Framed Basic Dimensions
A localization geometrical tolerance without datum reference frame and applied to a circular or rectangular pattern of 
constructed geometries for thread representations, can now be taken into account for automatic creation of framed/basic 
dimensions.

Font Linking Mechanism and True Type Collection Fonts
The support for the font linking mechanism and TrueType Collection fonts is available.

Managing 3D Annotations in Result Annotation Set
The contextual menu command Delete_Result_Feature allows the individual deletion of features in the Result Annotation 
Set.

Managing Hide/Show in Captures
The Show/Hide status of external part instances whose geometries are referenced by annotations in the Assembly 
Annotation Set can be managed in capture.

Mirroring Annotations
The mirroring of annotations can be controlled using the Mirror annotations option.

Propagating Geometry Selection for Feature Creation
The All same diameter, same pitch, parallel CG thread Cylinders option allows you to propagate the selection to the 
threads in the 3D part with the same diameter and pitch, and parallel axis with the selected Constructed Geometry Thread.

Text, Flag Note and Note Object Attribute Creation
Text, Flag Note and Note Object Attribute can be created on PartBody and Body features, some Part Design features, Axis 
systems, User Features and Technological Result features of Part Design Hole feature and User Features.

Using the Scope Range
The contextual menu command Geometry Connection Management allows you to see the last geometrical element to 
which the annotation was linked to in case of broken links.

Creating an Automatic Constructed Geometry

Constructed Geometry Circle
A constructed geometry circle can be created from cone-plane, cone-cylinder or cone-cone intersection. 

Highlighting Represented Geometry for Constructed Geometry
Selecting a constructed geometry (generated automatically or managed manually) highlights the represented geometry.

Introducing the Tolerancing Advisor

Annotations Attached to First Selected Feature
The dimension or annotation created using propagation commands is attached to the first selected geometrical feature.

Runout Tolerances in Revolute Surface
The following commands are available for single and multiple revolute surface selection: Circular Runout Specification 
and Total Runout Specification. 

Managing 3D Annotations in 3D XML Files

Support of Aligned/Offset Section Cut/View 3D Clipping
The 3D clipping is displayed on selecting the Aligned/Offset Section Cut/View in the specification tree or geometry. It is also 
displayed when selecting a capture that has a component of Aligned/Offset Section Cut/View.

Support of Text, Flag Note and Note Object Attribute
The geometrical element is highlighted when Text, Flag Note or Note Object Attribute is selected and vice-versa.

Support of Show/Hide of Part Bodies and Geometrical Sets When Displaying Capture
The Show/Hide status of part bodies and geometrical sets is respected when displaying a capture.

Support of Tolerance Schema Applied to User Features
The geometric features, dimensions, tolerances and annotations that are linked to the tolerancing schema are highlighted 
when the Nx text is highlighted.

Customizing Settings

Tool > Options > Mechanical Design > Functional Tolerancing & Annotation > Dimension tab > Analysis Display Mode area



The Activate analysis display mode option allows you to customize 3D annotations using 
different colors according to their types and status.

Tool > Options > Mechanical Design > Functional Tolerancing & Annotation > Display tab > Capture display area
The Mirror annotations option defines whether the annotations are automatically mirrored when displaying a capture.

Tool > Options > Mechanical Design > Functional Tolerancing & Annotation > Tolerances tab > Chamfer Size area
This option defines the tolerance options for chamfer size. 

Tool > Options > Mechanical Design > Functional Tolerancing & Annotation > View/Annotation Plane tab > Dimension And Annotation 
Default Position Along Normal View area

The Try to create in the annotation plane (Z=0) option defines whether the application always tries to create dimension 
or annotation in the plane of the current annotation plane when its definition allows to do it. Thus this option defines the 
dimension and annotation position at creation.

Tool > Options > Mechanical Design > Functional Tolerancing & Annotation > Tolerances tab > New Size Tolerances Creation area
The Propose the last created tolerance values option defines whether the last tolerance type and values defined in a 
command should be proposed as default for the next command.

Tool > Options > Mechanical Design > Functional Tolerancing & Annotation > Tolerancing tab > User Features Tolerancing Schemas 
Catalog area

This option allows you to define the path to the tolerancing schema catalog that is to be used for automatic tolerancing of 
user feature or technological result of user feature



DPM Assembly Process Simulation

New Functionalities

Generate Track command has been added
Users can select edges on the geometry, and generate tracks from the edges.  Once the initial track has been generated 
from the edges, the track can be modified.

Review Annotation Activity has been added
The Review Annotation Activity command enables users to allow 2D annotations to appear within simulations.

Enhanced Functionalities

The Filter dialog box for Analysis Information has expanded
Users can now select from among multiple move activities and analysis objects for filtering, as well as filtering for message 
levels.

Dragging the slider on the Player pop-up toolbar enables users to see the track simulation
In previous releases, users could not see the effects of attaching a section to a track until after a simulation was run; now 
users can see it as they move the slider.

When you select define the shuttle as part of a Move Activity, the Preview window now has a Tree tab
This tab enables users to see the names of all parts selected as part of the shuttle.  Users can still preview the graphical 
representations of the parts via the 3D tab.

Shuttles may contain multiple groups and manufacturing assemblies 
In previous releases, shuttles could only contain one group and a parent shuttle could reference another shuttle.  In this 
release, each group is treated as an object, and users can select as many objects as they like. Similarly, users can include 
manufacturing assemblies within shuttles.

The Annotation Activity command now works for 3D annotations as well as FD&T annotations
In previous releases, only F&DT annotations could be selected for the Annotation Activity command.

When you click the Activate Analysis button from the Track dialog, you can edit the analysis object
Users have the option to edit one analysis object at a time while creating a move activity; they do not have to stop creating 
a move activity to use the analysis commands.

The scope of analysis can be set to global or local
The Activate Analysis command enables you to bind analysis objects to a move activity.  You can now determine whether 
analysis objects that are bound to move activities can be observed globally (throughout an entire simulation) or locally (only 
during the move activity to which the object is bound).

The Player toolbar has a distance parameter
Users can interpolate along the track with a set distance.  Also, the Sampling Step option in the Player Parameters dialog 
box can be set for distance as well as time.

Customizing Settings

Snap Sensitivity in the DMU Manipulation tab has been altered
The default value for the Orientation option has been changed to 20 deg.

 



DPM Fastening Process Planner

Customizing Settings
You can optionally create a new manufacturing fastener when you modify the position of a fastener and then assign the fastener to a 
new process

If you do not select this option, modifications to the manufacturing process are propagated to all processes to which the 
fastener is assigned.

 



DPM Machining Process Planner

Enhanced Functionalities

IPM Diagnostics Tool 
This enhancement provides the capability to make the MOs correction before updating the IPM. The IPM diagnostics tool will 
report the diagnostics for the activities which will result into IPM generation failure. This will allow to make necessary 
modifications to the MOs so that IPM will be generated successfully and thereby ensure downstream associativity (drawing, 
FTA) when the IPM is updated. 

Delete Automatic Save at Creation Time 
This enhancement provides flexibility to set the IPM Name using Save Management. The IPM will be saved with this name to 
the save directory. 

IPM State in Automatic Resolution of Stock 
In DPM Machining Operation Preview, this highlight generates correct IPM solid, for the material removed during MO. 

IPM Generation Mode Localized to Machining Operation 
This enhancement provides the capability to set the IPM Generation Mode locally for each MO and use it for IPM generation 
over-riding the tools-option set globally. 

Extract Drawing on Activity 
This enhancement provides the capability to extract drawing from a Process node that does not have any Machining Feature. 
The drawing extracted will have the final drawing of previous Part Operation level. 

Create IPM Using Design Reference 
This enhancement will change the current behavior that IPM is generated based on Stock Part Reference to IPM based on the 
selected reference system. If you does not select anything the IPM will be generated based on Stock reference. 

Part Design Features allowed in Generic Machining Operation 
This highlight enable to select negative Part Design features in addition to Part Bodies in a Generic MO, facilitating IPM 
generation directly with features defined in the design part. 

Body in Machining Operation and IPM Generation 
This enhancement provides the capability to the user to assign a Part Body to any MO in order to be integrated to the IPM 
Generation engine. The Part Body assigned as IPM Primitive has been previously created manually in Part Design workbench. 
When a part body is assigned to an MO, the part body will be used as IPM primitive for In-Process Model generation instead 
of using the MO parameters. 

Tapping Information in IPM Drawing 
With this enhancement, Tapping Information is now provided in IPM Drawing. 



DPM Process and Resource Definition, Process Definition 
and Manufacturing Hub

New Functionalities

DPM Process and Resource Definition

You can now add or delete non-default columns to a Gantt Chart
Users can add columns to the Gantt chart that contain attributes that are in the properties of the activity or resource.  The 
attributes can be user-created attributes, created in Knowledgeware.  In addition, the calculation of the process duration is 
now calculated using the scientific calculation time analysis.  The parameters used in these calculations' formulae are 
available for viewing in the Gantt chart.

Replace the top node of a product
You can now replace the top node of a product while keeping track of the links within the process.

Search the Gantt charts
The Gantt chart now offers a search mechanism that is available in all Gantt charts.

Manufacturing Hub

Validation Pattern for Property Pages
You can validate inputs for attribute values in the Property page using Validation Pattern.

Load Context
You can load context (Manufacturing, Volumetric, and User) computed by Context Solver Batch. 

Product/Resource Tree Display Order
This functionality allows the DPM product/resource tree to be ordered in the same manner as the DELMIA Process Engineer 
product/resource tree.

Enhanced Functionalities

DPM Process and Resource Definition

Tooltips have been added to control flows in the PERT Chart and related viewers
If two activities are linked, the tooltip displays that information.  When a switch activity is linked, the output number also 
appears in the tooltip.  The tooltips also show precedent constraints.

Resources selected in the Gantt chart are cross highlighted in the PPR tree and in the geometry
Conversely, selecting resources in the tree or geometry cross highlights in the Gantt chart. If an object is not visible in the 
PPR tree because the tree is collapsed, the parent node is highlighted.

Uneditable cells in the Gantt chart are marked in gray
This clarifies for the users which cells may be modified and which cannot.

Process Verification has a Show Current Activity's Products
This option enables you to see only those products associated with the current activity. This option is also available for TSAs 
in the Process Verification Across Resources dialog box.

Process Verification enables you to hide all unassigned resources
This option is also available in the Process Verification Across Resources dialog box.

Process Verification enables you to select which activity you want to see after a switch activity
This option is also available in the Process Verification Across Resources dialog box.

Customizing Settings

DPM Process and Resource Definition

New display options for the Gantt Chart
The display options for the Gantt chart have been re-organized. In determining whether you want to see specified or 
calculated times, you can now differentiate between how you want the time displayed for the parent and leaf node.  In 
addition, you can select your own colors for specified and calculated times. You also no longer must have your Gantt chart 



left-aligned; you can choose to have data centered within a column or right-aligned.
Moved options

The Consider Product Flow option has been moved from the Gantt Chart tab to the DPM > Manufacturing System 
Definition > General tab because that option only applies to the Manufacturing System Definition. For the user's 
convenience, the Display Activity Relations options are available from the context menu on the Gantt chart and are no 
longer part of the customizing settings.

Verification has added Navigation options
You can choose to retain or ignore the effect of a Hide/Show command on the visibility of a product or resource during 
process verification. Also, you can choose whether to see the first or last child process when navigating down. This option 
applies to both the Process Verification and Process Verification Across Resources commands.

Server Computed Context Options
This option controls the load of a pre-computed context.

Load 3D States and Positions
This option is enhanced to load all 3D states and positions defined on upper level parent products and resources.

PackNGO
You can specify the pre-defined directory path for storing the pack and go data set.

ProductList/ResourceList Display Order
A new option Manufacturing Hub Order is added to ProductList/ResourceList Display Order.

 



DPM Review

New Functionality

Process Scene has been added
This command enables you to see thumbnails depicting the process at the time an annotation review activity has been 
created.



Electrical Harness Simulation

New Functionalities

Control Points
The actions to assign, change, add and delete control points on a bundle segment have been modified. The control points are 
named based on their position in the bundle segment definition curve. Two types of control points are used: user-created 
and engineered. 

Moving Multiple Cables
The Move Multiple Cables will allow you to manipulate the position of connectors, clamps, and routed products. As these 
components are manipulated through space, the harnesses connected to these components will also move to follow the 
components through space within limits of solvability. 
The new functionality is available through the new Move Multiple Cables Toolbar.

Customizing Settings

New Environment Variables are now available
These settings enable you to control material properties, penetration avoidance, and various solvers.



Generative Shape Design, Optimizer, Developed Shapes & 
BiW Templates 

New Functionality

Creating Dynamic Section View 
This capability allows you to visualize 3D section view of a part at a position specified by section plane. You can choose the 
position to cut by moving section plane.

Enhanced Functionalities

Creating Points
A new Distance along direction option is available when creating a point on a curve.

Creating Multiple Points and Planes 
You can now choose the repetition mode between Absolute and Relative. 

Creating Parallel Curves
You can now use Laws with two parameters (Linear or S type) when creating several curves.

Creating Conic Curves 
The Default Parabolic Result check box lets you create a parabolic conic curve. 

Creating Extruded Surfaces
A new Mirrored Extent option enables to create a mirrored surface. 

Creating Cylindrical Surfaces
A new Mirrored Extent option enables to create a mirrored surface. 

Creating Offset Surfaces
The accuracy of error diagnosis has been increased. For temporary analysis, Surfacic Curvature Analysis can be used.

Creating Edge Fillets / Creating Variable Radius Fillets / Creating Chordal Fillets
In Tangency mode, the tangent continuous edges of the selected edge are now managed to ensure a better fillet stability 
and robustness. The productivity is improved as more fillets are automatically rerouted in case of design changes.
The variable fillet radius is displayed at the end of the propagation of the selected edge.

Reshaping Corners
The setback distance value can exceed the length of the corresponding concurrent edges.

Isolating Geometric Elements
You can now isolate all GSD features. 

Managing the Background Visualization 
You can select an annotation text that will be used to determine a plane.

Analyzing Using Parameterization 
A new filter is available called All Axis Systems.

Repeating Objects



You can now choose the repetition mode between Absolute and Relative.
You can now activate both Repeat and Datum modes at the same time.

Selecting Using Multi-Output
All common inputs are now directly aggregated under the Multi Output feature.

Instantiating Power Copies
Multi-Selection is now available prior to entering the command.

Creating Extruded Volumes 
A new Mirrored Extent option enables to create a mirrored volume.



Manufacturing System Definition

Customizing Settings

Consider Product Flow option added
The Consider Product Flow option has been moved from the main Digital Process for Manufacturing > PERT Chart tab to 
the Digital Process for Manufacturing > Manufacturing System Definition > General tab because this option only 
applies to Manufacturing System Definition.

 



Part Design

New Functionality

Dynamic Sectioning

This capability allows you to visualize 3D section view of a part at a position specified by section 
plane. You can choose the position to cut by moving section plane.

Enhanced Functionalities

Creating Threaded Holes
While selecting a standard thread type, if the diameter of a hole set by you is matching with the thread standards, the 
related thread description automatically gets selected as per the thread standards.  
If the diameter of a hole set by you does not exist in the standard file while selecting a standard thread type, a warning 
message is displayed. In this case, the diameter is set to the first value in the standard file.

Creating Edge Fillets
A new Intersection with selected features selection mode is available for filleting edges.

Creating Edge Fillets / Creating Variable Radius Fillets / Creating Chordal Fillets
In Tangency mode, the tangent continuous edges of the selected edge are now managed to ensure a better fillet stability 
and robustness. The productivity is improved as more fillets are automatically rerouted in case of design changes.
The variable fillet radius is displayed at the end of the propagation of the selected edge.

Reshaping Corners
The setback distance value can exceed the length of the corresponding concurrent edges.

Reordering Features
You can now move features from one branch to another and from an ordered root to a non-ordered root.

Customizing

Part Document
You can now choose to import colors on features created through the Copy Paste As Result or Copy Paste As Result with Link 
options.



PPR Navigator

New Functionalities

Display Relationship Tab Pages last in Browser 
This functionality allows to display relationship tab pages left/right in browser. 

Restrict Filter Set to Filter Areas 
This functionality restrict availability of the filter created in a filter area to that particular area only. 

ENOVIA Change Order 
A new type of change order ENOVIA Change Order is available in Manufacturing Hub. It is created by the CO Loader in MCM 
Projects. 

Sorting of Change Orders 
This functionality allows to sort and override the change orders. 

Support for Folder Structure for Labels and Label Categories 
This functionality provide support for folder structure for labels and label categories during filtering when opening a project in 
DPM from the Manufacturing Hub. 

Support for Deep Delete of Resource 
This functionality allows to delete resource data from PPR editor. 

Display Sorted Process Tree 
This functionality allows to display the sorted process tree in Select Process dialog box. 

Support for DL Names 
This functionality support multiple locations for storing CAD data using existing setting product_cadpath. 

Enhanced Functionalities

Navigate Search Results 
You can navigate the search results through search next and search previous buttons. 

PackNGO 
You can generate Lite PackNGo with use of preset directory.



Real Time Rendering

Customizing Settings

Material
A new option enables you synchronize automatically material parameters and applied materials after a PowerCopy.



Sketcher

Enhanced Functionality

Creating a Line Normal to a Curve
This capability allows you to avoid position or shape modification of a geometry when creating a line normal to a curve.



Tool Selection Assistant

New Functionalities

Support all axis for weld gun approach direction
This option will apply to all the commands of Tool Selection assistant. Biggest impact will be seen in the way Pie reports and 
section planes are positioned. The pie report and section planes will be positioned as per the approach direction defined in 
the application setting. 
In case of Pie report: if a particular orientation of the weld gun is accessible then, the Axis of approach will lie in the green 
zone of the pie report. 
In case of Section plane: By positioning the section plane as per the approach direction, you will always see the right view in 
the section result window. 

Capability to update Robot Posture after changing the Robot Configuration in Generate stack of 2D Sections/3D Slices at the selected 
welds command

In Generate stack of 2D sections/ 3D slices at the selected weld, in current scenario once the user changes the Robot 
configuration using the Robot Configurations Combo box in the dialog, the corresponding change is not reflected. This 
highlight provides the functionality of changing the Robot configuration using the Robot Configuration Combo box in the 
Dialog. 

Change Pie report colors for Analyze Welds for Robot command
Currently, it is difficult to properly analyze the pie charts if the pie chart color resembles that of the surrounding resources 
color. This enhancement would help to properly analyze the results of the welds, by changing the color.

Enhanced Functionalities

User Interface Capabilities for Generate stack of 2D sections/ 3D slices at the selected weld
In Generate stack of 2D sections/ 3D slices at the selected weld command, currently you can't change the manufacturing 
location. This highlight allows user to move the manufacturing location with a compass manipulation.

User Interface Capabilities for Analyze Welds for Robot
In the Analyze Welds for Robot command, you are able to select multiple welds by multi acquisition.

Performance improvement for Auto Gun Search Command
Auto gun search is the entry point command in process planning. It enables user to minimize amount of new tooling design 
for a new product. This command performs search over very large no. of weld guns and welds to enable validation. The 
improvement of performance of this command gives a significant value as; it directly reduces the time required to validate a 
new product.

Support gun position changes and moving manufacturing location, during manual weldgun search
With this option, you can lock the manufacturing location by using Lock Location check box. After manipulating the 
manufacturing location using compass manipulation and on checking Lock Location check box, the compass disappears and 
you can't modify the manufacturing location with out un-checking the Lock location check box. 



Wireframe and Surface

New Functionality

Creating Dynamic Section View 
This capability allows you to visualize 3D section view of a part at a position specified by section plane. You can choose the 
position to cut by moving section plane. 

Enhanced Functionalities

Creating Points
A new Distance along direction option is available when creating a point on a curve.

Creating Multiple Points and Planes 
You can now choose the repetition mode between Absolute and Relative.

Creating Extruded Surfaces
A new Mirrored Extent option enables to create a mirrored surface. 

Creating Cylindrical Surfaces
A new Mirrored Extent option enables to create a mirrored surface. 

Isolating Geometric Elements
You can now isolate all GSD features.

Managing the Background Visualization 
You can select an annotation text that will be used to determine a plane.

Analyzing Using Parameterization 
A new filter is available called All Axis Systems.

Repeating Objects 
You can now choose the repetition mode between Absolute and Relative.
You can now activate both Repeat and Datum modes at the same time.

Selecting Using Multi-Output
All common inputs are now directly aggregated under the Multi Output feature.

Instantiating Power Copies
Multi-Selection is now available prior to entering the command.



Device Building

New Functionality

Controller Synchronization
Controller synchronization allows you to to synchronize a controller profile instance with the reference. Data can be imported 
from the reference, as well as propagated from the instance down to the reference.



Device Task Definition

New Functionality

Editing the mount offset
Double-clicking on a mounted tool displays the Set Tool dialog box and snaps the compass to the tool base. The compass 
can then be used to change the offset between the mount plate and the tool device base. 



Workcell Sequencing

New Functionality

Sequencing Tasks
Automatically create Process Activities for Robot/Device Tasks, as well as assign the Robot/Device and set the Active Task 
link.



DMU Kinematics Simulator

Enhanced Functionalities

Managing the Mechanism Dressup
The dress-up definition is improved, the selection behavior is changed.



Human Activity Analysis

New Functionalities

3D Display of Biomechanics Results
A better way to display the results in 3D, each segment results are highlighted in the list when the related segment in the 3D 
model is selected.

Defining Loads on Other Segments
This provides a more realistic behavior of the Biomechanics Analysis by allowing the use of loads positioned on segments 
other then just the hands. Therefore, Biomechanics Analysis can be applied on manikin having loads on shoulders, forearms 
and back.

Enhanced Functionality

Increased the number of analyzed joints - wrists
For a more complete analysis of the human biomechanics Results a new analysis will cover both wrists in flexion-extension 
and Radial-Ulnar deviation.



Human Builder

New Functionalities

Anthropometry - German, Chinese (Taiwan)
The anthropometry also includes German and Chinese (Taiwan).

Displaying Balance
This displays the support polygon of manikin's balance in the viewer. The color of the support polygon will change from 
green to red if the manikin loses his balance.

Defining the color of the Manikin Referential
Choosing the color of the manikin referential for each manikin enables the client to differentiate them and to make sure that 
it doesn't blend with the environment.

Auto Grasp Offset
The need for this highlight comes from wanting more control over an existing function that automatically generates a grasp 
posture of the hand by checking the collision between the hand and one or several objects to be grasped. A new option 
would allow you to edit the offset that control the reaching position of the hand which is currently automatically set to a 
default value.



Human Measurements Editor

New Functionality

Anthropometry - German, Chinese (Taiwan)
The anthropometry also includes German and Chinese (Taiwan).



Human Task Simulation

New Functionalities

Editing MoveToPosture Activities with constraints
A new command will be provided under the contextual menu of MTP and also accessible from /Edit /MoveToPosture object / 
Synchronize 3D Model.

Manikin Motion speed
This highlight provides the capability to set default joint speed for each manikin segment based on ergonomic data and also 
provides the capability to specify a rating on Human Task, Human Activity Group and Walk Activity.

Opening a Active Task tree
Users modify the task and child activities from within the active task set on process activity (in the Process List). Modifying 
the task in the process tree provides the position of objects in the process sequence. In the current release, when users want 
to modify the active task in a process activity, it is very difficult to find the active task since all tasks under the manikin 
resource are displayed. This makes the selection of active task not only cumbersome but also error prone.

Reassigning Human Operations
This provides the ability to re-assign human operations within the same process document or across different process 
documents.

Enhanced Functionalities

Structural change of Operate
This highlight fits into the final assembly workflow of the user and helps in providing dependable & consistent simulation time 
and reduces the time required for creating Operate activities thereby improving productivity.

Line Balancing with Human
This highlight provides the ability to set the HAG as an active task freely without any restrictions.

Collision Free Walk enhancements
True collision free walk or absolute collision free walk and indicates the collision free algorithm will account for arm swinging, 
picked part (if any), current body posture for computing the walk path.

Move to Posture Activities enhancement
3D state is displayed in the MTP node under the PPR tree. The icon of MTP will be changed to indicate a 3D state has been 
assigned to the MTP. Upon removing the 3D state assignment, the icon will be restored to normal.

Operate Walk with Device Move
The Operate Walking command can be used to define Operate Walking with Robot Tasks and Device Tasks.



3-Axis Surface Machining

New Functionalities

Advanced Finishing
Dedicated to the one-shot machining of grooves.

Enhanced Functionalities

Machining/Slope areas
You can add user subsets for horizontal and intermediate areas.

Contour-driven operations
Parallel contour guiding strategy manages inner island through manual selection or automatic detection.
Parallel contour guiding strategy proposes to take the check into account when selecting the guide via Select faces.
Some parameters have been moved from the Radial to the Strategy tab.
A Tool Axis Motion NC macro is now available for Approach and Retract.

4-Axis Curve Sweeping
Parameter Max discretization step has been added to improve the quality of the tool path.

Sweeping
A Tool Axis Motion NC macro is now available for Approach and Retract.

Spiral Milling
A Tool Axis Motion NC macro is now available for Approach and Retract.
Start points can be defined.

Pencil
A Tool Axis Motion NC macro is now available for Approach and Retract.

Collision checking
User representations can be used in collision checking.

Probing operations
NC_CYCLE_OFF has been enhanced.

 



Lathe Machining

Enhanced Functionalities

Maximum Spindle Speed at Operation Level 
This functionality enables to define the Maximum spindle speed at machining operation level (by default, the value is the 
Maximum spindle speed set on the Part Operation). This setting is available for all turning and axial machining operations. 

Local Offsets to the Part Profile in Rough Turning Operation 
This enhancement provides the Local Information functionality in the Rough Turning operation. In addition to the global 
offsets that can be assigned to the part profile, you can also add local offset values. 

Angular Units (length per revolution) for Air Cutting Feedrate 
In addition to Linear units (length per minute), Air Cutting feedrate can now be specified in Angular units (length per 
revolution). 

End Limit Option for Grooving Turning 
This functionality helps to define the end limit on the profile geometry of single flank groove turning operation and also 
provide an option for specifying end limit offset value. This helps to control the tool path on the open end of groove turning 
operation. 



Multi-Axis Surface Machining 

Enhanced Functionalities

Spiral Milling
Start points can be defined.

Collision checking
User representations can be used in collision checking.

 



Multi-Slide Lathe Machining

Enhanced Functionalities

Toolpath Points Based on Turret 
A new Toolpath points based on the turret involved in the Manufacturing Program option is provided in the Part Operation 
editor. This option enables you to output the toolpath points based on the turret axis system for turning operations. 

Tool Compensation Output for B-axis and C-axis 
A new Tool Path with B and C-axis option is provided in the Part Operation editor. When this option is selected, the 
generated tool path takes into account the defined B-axis angle and C-axis option. 
Compensation points other than P9 are rotated about P9 by an amount specified as the B-axis angle and will become a 
mirror image point about the turret axis in case of a tool axis flip (C-axis). 



Multi-Pocket Machining

Enhanced Functionalities

Multi-Pockets Flank Contouring
Two tool axis guidance strategies are available.

Collision checking
User representations can be used in collision checking.

 



NC Machine Tool Builder

Enhanced Functionalities

Defining Machines with Interchangeable Heads 
Previously, the creation of Milling Machines and Milling Heads, with the capability to do a head change during simulation, was 
not supported. This functionality enables to create such machines to be used in simulation. It allows to create a new Milling 
Machine Head, which can then be inserted into the milling machine CATProduct. 

Defining Tool and Work-piece Mount Points 
This section describes how to create, modify and delete multiple tool and work-piece mount points on milling machines, 
using the Create Mount Point command. 



NC Machine Tool Simulation Machining

New Functionalities

Display of Stock Color during Simulation 
This functionality enable you to visualize the tool colors on the stock during material removal with machine simulation. The 
material removed is displayed in the color of the tool and helps to visualize the stock effectively. 

Machine Instruction Support for Interchangeable Milling Heads 
For Mill-Turn Simulation, you can define Machine Instruction activities on Interchangeable milling heads. 

Customizing Settings

Integrated Material Removal 
A new option Display Tool Color on Stock is added. You can enable tool colors on the stock during material removal with 
machine simulation. 



NC Manufacturing Infrastructure

Enhanced Functionalities

Tool Query without Tool Type 
This enhancement allows you to make a Tool Query without specifying a tool type. 

Reverse Machining Consistency 
This enhancement extends the support of Reverse Machining Conditions to all relevant Machining Operations. In addition, 
there will be an indication to identify Reversed Machining Operations in the MO name.
If any of the selected operations are locked, you will be notified about this and there will be an option to unlock these 
operations and to apply Reverse Machining Conditions. 

Machining Directions at Machining Process Instantiation 
With this enhancement, you can instantiate a machining process by taking into account either the absolute or current axis 
system assigned to a machining axis system change for the machining direction. 

Auto-sequence Improvements 
This enhancement reduces the time required to sequence operations for any rules and provides an new option for sequencing 
with a minimum number of tool changes. 

Collision checking 
User representations can be used in collision checking. 

Customizing

Reverse Machining 
The name of MO gets appended with the Reverse Keyword. 

During NC Code Generation 
No generation of NC code if MO is not updated. 

MP Instantiation 
When a machining process is instantiated, the tool axes and machining directions of the activities in the MP keep their 
absolute positions. 



Prismatic Machining

New Functionalities

New Trochoid Milling Operation 
A new milling operation dedicated to hard-material machining is provided. The trochoidal motion ensures a constant material 
removal which increases the tool life duration. 

Pocketing Operation 
This highlight provides capability to machine pocket areas without jump motion on check elements. 

Bottom Plane Definition Using a Point 
This highlight allows you to specify the bottom plane using a point for Pocketing, Profile Contouring, Groove Milling, and 
Facing operations. When you do not have a floor to define for a profile, you can select a point as the bottom and normal of 
the bottom would be taken from the tool axis. Any change in the tool axis would effectively change the direction of bottom 
(always keeping it perpendicular to the tool axis and passing through the selected point). 

Enhanced Functionalities

Extended Multi-edit Support 
Multi-edition allows you to modify the common parameters of several Machining Operations of the same type. In addition to 
the operations already supported, this capability is now available for Pocketing and all Axial Machining operations. 

Power Option in Axial Operations 
This enhancement allows you to define the Power parameter for appropriate Axial machining operations. You can take the 
Power parameter value from the tool assembly (as in the previous Release) or you can define the Power parameter value 
specific to the operation. 

Helix Approach Macro in Circular Milling 
This enhancement provides capability to rough core the hole by Helical movement before a circular finishing path. 

Option to Disable Stock Management at Operation Level 
You can now choose to deactivate stock management for specific operations. The creation of the Output stock and/or the 
handling of input stock in toolpath computation can be controlled at machining operation level. 



Prismatic Machining Preparation Assistant Machining

Enhanced Functionalities

Axial Features Filter Capability 
This enhancement provides the capability to create machinable axial features based on user-defined filter criteria. 

Creating Machinable Axial Features and Machining Patterns 
This enhancement allows to include User parameters defined on holes in Machining Axial Feature as additional parameters. 
You can use these parameters as criteria to create Machining Pattern, or within formula and checks when defining Machining 
process. 



DPM Work Instructions

New Functionality 

Re-Using Process Tolerancing and Annotations 
This new command enables you to associate existing PT&A data with a revised part as long as the geometry has not 
changed.  It works both for PT&A data associated with a single part and for PT&A data associated with multiple parts.



Generative Drafting

Enhanced Functionalities

Associative Graphical Dress-Up Features
The graphical properties of drawings extracted from CATProcess in DELMIA products are retained during view modification or 
update.

Detail Circular View Arrows
The orientation of detail circular view arrows is compliant with the international standards for detail view/profile and quick 
detail view/profile.

Generating an Advanced Bill of Material
The part/product properties defined in Properties dialog box using Define other properties... option can be customized in 
the Bill of Material.

Offset Constraint
The section profile can be created using the Offset constraint in Tools Palette, which keeps the profile associative to the 
geometry in offset section view/cut and aligned section view/cut.

Persistency of Generative View Style During Update
The generative view style applied to a view is retained during view update. To remove the generative view style applied to 
the view, a new command button Remove style has been added to view Properties dialog box.

View Callout Styles
The callout styles for projection and section view callouts has been modified.

Projection of 3D Geometry in Approximate Mode

Persistency of Graphical Dress-up
The persistency of graphical dress-up is available in Approximate views.

Projection of 3D geometry in Approximate Mode
The 3D wireframe geometry can be projected in Approximate views.

Creating and Modifying Views from a .model
The 3D wireframe geometry in .model documents can be projected in Exact And Approximate modes.

Customizing Settings

Tools > Options > Mechanical Design > Drafting > View tab > View generation area 
The Approximate/Raster/CGR views update status setting allows you to choose the up-to-date status computation 
mode depending on the type of data for Approximate/Raster/CGR views.



Interactive Drafting

New Functionalities

DS ISO 1 Open Type Font 
This new font, based on the ISO 3098 standard defining text representation, is delivered along with the application to ease 
the exchange of standardized documents. Four new standards (ISO_DS, ISO_3D_DS, JIS_DS, JIS_3D_DS) are available that 
use DS ISO 1 as the default font. 

Upgrading Geometry in Views 
You can now upgrade geometry in views, which will let you benefit from the latest technological enhancements brought to 
sketched geometry in V5. 

Enhanced Functionalities

Creating a Line Normal to a Curve 
The default command has been changed. You can now select a point on a curve as a start point, and create a symmetrical 
line if needed. 

Font Linking Mechanism and True Type Collection Fonts 
The support for the font linking mechanism and TrueType Collection fonts is available. 

Customizing Settings

Tools > Options > Mechanical Design > Drafting > Administration tab > Prevent view geometry upgrade 
This option deactivates the Geometry Upgrade contextual command (used to upgrade sketched geometry in views) which 
is available for drawings, sheets and views.



Shop Order Release

New Functionalities

Performance and Quality in SOI Generation Service: Dedicated EXE for SOI Generation
You will  be able to automate the SOI generation service with improved performance in terms of elapsed/CPU time. Your 
third party applications would call COM Application and place request for SOI generation.

Image Capture based on the Process Verification
This allows you to have a way to visualize the build up of products as the process progresses. You can display Cross 
highlighting based on Parts or EI consumption in the captured images.  This is generated by using the command, Image 
Capture for a Process in DPM Shop Order Release.

Support for batch generation of process 3D XML in Create Shop Order API 
3DXML's initiative aims at providing a generic file format and associated tools to support the efficient use, distribution and 
visualization of 3d data.

SOI-Generation-Services through Web services
Web services are based on the concept of service-oriented architecture (SOA). SOA is the latest evolution of distributed 
computing, which enables software components, including application functions, objects, and processes from different 
systems, to be exposed as services.

Service Orientated Architecture (SOR) Web services
To improve the deploy ability & scalability, this project aims in launching the SOR functionalities through state-of-art Web 
Services which are developed over the DS Web Services Infrastructure and are deployable in packaged format.

Steps to deploy the Web services
This section explains if, and how, the user or the administrator is given the opportunity to change the way the highlight 
behaves. 



MULTICAx AD Plug-in

Enhanced Functionalities

3D DXF
3D Faces are now supported in DXF files (existing limitation in documentation removed).
DXF 3D AutoCad 2007 is now supported.

 



MULTICAx ID Plug-in

Enhanced Functionalities

IDI NX5 (MS 13) and NX6 are now supported.



MULTICAx PD Plug-in

Enhanced Functionalities

ProE WF4 is now supported.



MULTICAx SE Plug-in

Enhanced Functionality

SolidEdge assemblies are now supported.
 



MULTICAx UD Plug-in

Enhanced Functionalities

UG NX4 and UG NX5 are now supported.

Removed Functionalities

Indirect mode is no longer available.



CSM Module and Block Editor

Enhanced Functionalities

Partial Import 
Some data can be added to a block using the partial import. 
  

Ergonomics Improvements 
New icon in the Product tree for the Internal Logic, Control Logic and Runtime view

The user can sort names and types by alphanumerical order in the dialog box

The user can add comments in the different editors (the comment are represented by a kind of post-it).



HMI Control Panel Design

New Functionality

Save and Restore Panel State 
During a simulation, the user can save and restore the state of the panel by controlling the inputs SaveValues and 
ReadValues. 
The new function Edit Saved Values allows the user to edit the state of the panel and to modify it if necessary. 
Refer to Editing Saved Values 

Enhanced Functionality

"Display" gadget in write/read mode 
Until now, the gadget "Display" displayed values of the input signal. Now, the user can enter the value in the gadget field 
during the simulation.
Refer to Inserting a Display Value.



CLM Device Logic Design

Enhanced Functionalities

Automatic Internal Logic Generation 
A new command allows the user to generate automatically the code of the internal logic that manages Device Tasks, Robot 
Tasks and Robotic IO's. 
Refer to Generating Internal Logic Automatically.
  

New Commands Replacing the External Functions 
The 3D interaction functions in the SmartDeviceLib library are now replaced by commands. It is no longer necessary to enter 
the name of the function and its parameters in an SFC action. 
Refer to:
Piloting a Device Task 
Getting and Setting the Joints of a Device 
Moving a Device to a Home Position 
Setting a Device Color 
Tracking the Click on a Device 
Selecting a Home Position 
Getting and Setting TCP values 
Reading and Writing Robotic IO's 
Defining a Device Motion from the DOF Values 
  

Partial Import 
Ports, instances, signals, connections and SFC behaviors can be updated/added to an existing block using the command 
Partial Import. Refer to Using Partial Import. 
  

New Management of the Resource Sensors 
In order to ease the management of the data returned by the sensors, the behavior of the signals Detected and Value has 
been changed. Refer to Creating a Resource Sensor. 

http://dsdoc/doc20/online/dldug_D2/dldugat0800.htm


CLM SFC Editor

Enhanced Functionality

Usability Improvement 
The user can add comments in the SFC+ and Block editors (the comments are represented by a kind of post-it). 



CLM FBD Editor

Enhanced Functionality

Usability Improvement 
The user can add comments in the FBD editor (the comments are represented by a kind of post-it). 



CLM Ladder Logic

Enhanced Functionality

Usability Improvement 
The user can add comments in the Ladder editor (the comments are represented by a kind of post-it). 



CSM Device Control Connection

Enhanced Functionalities

New OPC parameters 
External block (OPC protocol): two new parameters have been added to monitor the OPC server read and write modes. The 
write mode can be synchronous or asynchronous. The read mode can be cache or device. 

Check block definition 
This new Check command allows you to verify that the definition of the external block (OPC protocol) is compliant with the 
tags defined on the OPC server. 



3D Simulation for Manufacturing

New Functionality

Exporting analysis results and device messages to a file
Analysis results and messages related to various devices/robots obtained when running simulations can be saved to external 
files.



Data Exchange Interfaces

Enhanced Functionalities

DXF 
It is now possible to import a file DXF/DWG into 2D Layout for 3D Design.
Autocad 2009 is supported.

Customizing Settings

STEP: Global nested assembly or Partial nested assembly 
Let you activate a global or a partial export of nested assemblies. 

STEP: 3D Annotations 
Lets you import/export 3D annotations. 

COPS validation properties 
COPS validation properties handle the points on edge (sharp sampling points) in addition to the points on surface. 



Infrastructure

New Functionality

Fonts
DS ISO1 Open Type font is now provided to display annotations with respect to the various ISO standards defining text 
representations.

Enhanced Functionalities

Configuring Printer Drivers
Ability to embed or link fonts when generating PDF documents. 

Digital Rights Management (DRM)
Full support of AD-FS.
Full offline feature.
Support of CATProcess and CATAnalysis formats.

Reversing Actions
Ability to flush the history.

Running Batches Using the Batch Monitor
More batches are available.

Printing Documents
Implementation of DRM.

Capturing Images
Implementation of DRM.

Recording Interactions in Video Format
Implementation of DRM.

Running the PrintBatch
Implementation of DRM.

Customizing

Fonts
Support of TrueType Collection fonts and font linking mechanism. 
 

Digital Rights Management
Ergonomic enhancements have been made to provide the ability to switch anytime between a basic view and an advanced 
view.

PCS
A new option enables to prevent any unpredictable behavior in the Undo/Redo process if a document is open in several 
editors for modification purpose.



Product Structure

Enhanced Functionality

Product Structure Package
The LocationX, LocationY and LocationZ attributes are added for Assembly, Part and Product types to display the X, Y and Z 
coordinates of the instance location relative to its parent (based on the position matrix).



Administrative Tasks

Enhanced Functionality

 New entries in Configuration Tool
Two new entries Validation Pattern and Validation Pattern description has been added to the Configuration Tool. 



Automatic Line Balancing

Enhanced Functionalities

Merge Tool Capability 
ALB instantiate tools in the respective stations. If a tool is required by two different processes in one workplace, the software 
should instantiate only one single tool. 

Merge Part Bins 
Two new enhanced logistics planning modes are:

❍     No duplicate part bins for identical processes

❍     No duplicate part bins for same parts

 Enable Standard Processes 
This allows to create non-value-adding processes.

 Rotate Part Bins by 90˚ 
This rotate the part bin groups of the selected station or material area by 90˚.

 Edit Name of Shelves 
This allows to edit the name and number of the shelf.

 Change in Default Settings 
This changes the default settings of some of the options in the ALB customization.

 Show User Defined Attributes
 This feature allows to see user defined attributes in Process List, Balancing List View, and Workplace view. 

Reorder Columns 
This feature allows to Sort\Re-Order the columns (attributes) by drag and drop to different position and later those columns 
can be seen in the same position when it is loaded again in ALB Process List, Balancing List, and Workplace View. 

Free Placement of Part Bins
 The feature provides the following abilities.

❍     Place the part bins anywhere in the material area or outside corner when opening a new or old balancing, when moving processes 
within and across stations and when moving part bins within and across stations.

❍     New function to automatically rearrange part bins and shelves in material area.

❍      Mark inconsistent material areas and snap of part bins or shelves. 



EH to MH V5

Enhanced Functionalities

Computing Manufacturing Context
 The Manufacturing and planning contexts of a process can be calculated by new server interface that offers the possibility to 
get set of products assembled before the selected process. 

CAA Application Authentication
 Client has to authenticate itself at Manufacturing Hub by a unique authentication identifier. The authentication will ensure 
that only those clients can connect to the Manufacturing Hub that the Manufacturing Hub can authenticate as ‘known’ client 
applications. Manufacturing Hub will grant access only to those clients that have proper credentials. Manufacturing Hub 
administrator can authorize selected third-party clients. 

Customization Settings for Planning Context
 Customization settings for creating, deleting, and modifying Planning Context in E5.

 Version Management Support 
This feature make use of the origin of part versions and assembly relations that are stored on the Manufacturing hub as 
‘historical id’ to identify and handle the versions correctly

Boolean Attribute Filtering
 An additional filtering based on Boolean attribute value on the Part Master, Part Version, and Part Instance is possible, 
similar to the filters based on string attributes. Multiple filters may be defined and can be joined via the logical operation 
"AND". This feature is supported for all transfer modes, i.e. full/partial/incremental update. 



Finder

Search Criteria at Plantype Level 
This feature allows loading the finder search criteria to all other objects which are of same plantype.

 Language Id 
This feature allows Finder to search for the component with the stored name in specific language. 



General Introduction

Multilingual Support
 This allows to store values of attribute in multiple languages. 



Graphic Tools

Multiple Paths In Graphic Path Variable
Provide capability to support multiple locations as repository for CAD data using existing setting “product_cadpath”. ?  
Provide capability to import file locations (DLName file locations exported from V5) to Process Engineer. 



Manufacturing Change Management

Enhanced Functionalities

 ENOVIA Change Order
 A new folder “ENOVIA Change Orders” is available, by default, in Project library for MCM projects. 

Display ENOVIA Change Orders Sorted by Name
This allows to sort ECOs name and helps to find a specific ECO easily. All ECOs can be seen in a new resizable and scrollable 
dialog. PRE/POST override can also be applied to all ENOVIA Change Orders.



PPR Navigator

Enhanced Functionalities

 Changing Calculation Models Area Information
 The filter created in a PPR area can be made available for different plant area (Product, Process, and Resource). 

Invoke the Properties dialog via Script
 This allows to invoke the properties dialog of an object via script. The new method OpenProperties (ObjectId) in 
XScriptItemData class is introduced. Calling this new method inside a script, invokes the properties dialog/editor for the 
given objectId.

 Bookmark for PPR Tree Component
 This allows to bookmark the PPR tree component in Project window and later you can navigate to corresponding component 
with a Bookmark dialog box. You can view, rename, and delete the existing bookmark from the Bookmark dialog. 

Regular Expression Support for Property Pages
 A new property is added in config tool to support a regular expression. It helps to validate the entry for attribute in the 
property page. 

Migration to Objective Grid 12.0.1 
The existing Objective grid 10 has been migrated to Objective grid 12.0.1. 

Tab Repositioning 
This allows to display relationship tab pages (BOM Entry, Process creates product, Process first Processes product...etc.) 
right in the browser. 

Release Table wrt SFI
 To support Shop Floor Integration (SFI) a Release Table is provided for each object version.  

 Lock Manager 
You can create link while object is being edited by other user. As the objects locked in WRITE mode can be locked in LINK 
mode also. 

Invalid Names in Calculation Models
 Invalid names allowed in calculation models can be changed during filtering. 



Project Library

Enhanced Functionality

Creating Label Folders (org label) 
This allows to create organizational nodes (org labels) to manage Labels/Label categories. 



Scripting

Enhanced Functionalities

 IsValidExtendedEffectivity 
The function data IsValidExtendedEffectivity is added.

ReloadSelectedComponent 
The function browser reload selected component is added.

GetChangeEntryResult 
The function query GetChangeEntryResult is added

RunAsOwner 
The RunAsOnwer feature is applicable for both scripts and VBA macros.

Open Properties Dialog
Script actions and script commands cannot be invoked from the properties dialog which is invoked via vbscript or vbamacro. 

  



Settings

Enhanced Functionality

 DWIC.exe
 The default exe for Workinstruction composer is now changed to DWIC.exe. 

Finder: Load Search Profiles on Types
 This checkbox makes available the finder search criteria at the plantype level.

 Show Relationship Tab Pages in Browser at the End 
This checkbox displays relationship tab pages right in the browser.

 Number of Book Marks Items on Project 
This limits the number of bookmark componenets. 

Copy Filtered
 This allows to copy only filtered objects (children of the copying object). 



User Management

Enhanced Functionalites

 Changing the Password
New rules to check strength of DPE user’s password. It includes the following: 

❍     Password strength is enforced on selection of new password. This will be configurable for length of characters, inclusion of special 
characters, etc.

❍     Password expiration will be enforced on user login to DPE. Once a password has expired, when logging into DPE, you will get 
notification and forces to enter a new password with sufficient strength. The duration of time is configurable. 

❍     Failed login attempts are logged into log file. Logging will include machine identifier, user identifier, date, and time of the 
occurrence.

❍     After a designated number of successive failed login attempts to a given account, the account will be disabled until intervention by 
an administrator. This number will be configurable. The log will record this event.



Web Service Installation

 WebServiceVersion
 This functionality provides version information of the installed IPD Web Service. 


